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rÛønych przebiegÛw, potencjometry,
a†takøe monitor I2C, alfanumeryczny
wyúwietlacz LCD oraz szeregowy port
komunikacyjny TTY. W†symulacji moø-
na rÛwnieø uøywaÊ wszystkich kompo-
nentÛw mikrokontrolera, jak na przy-
k³ad: timery/liczniki, UART, komparator
analogowy, watchdog itd. Mog¹ one
pracowaÊ w†systemie przerwaÒ, jeúli
tylko jest to moøliwe w†ìprawdziwymî
mikrokontrolerze.

Uruchamianie wirtualnego sprzÍtu
u³atwia rÛwnieø wirtualny oscyloskop
wielokana³owy. PrzyjÍcie takiej kon-
cepcji pozwoli³o stworzyÊ narzÍdzie,
ktÛre powinno uproúciÊ etap urucha-
miania aplikacji, a†przede wszystkim
obniøyÊ jego koszty. Konstruktorzy nie
trac¹ czasu na mozolne lutowanie
uk³adu, nie musz¹ takøe korzystaÊ
z†drogich emulatorÛw sprzÍtowych ICE
(In Circuit Emulator). UnikniÍcie fi-
zycznego montowania prototypu po-
zwala na rozbicie projektu na wiele
zadaÒ, ktÛre mog¹ byÊ wykonywane
jednoczeúnie przez ca³y zespÛ³ inøy-
nierÛw. Do zera zmniejsza siÍ ryzyko
fizycznego uszkodzenia uk³adu. Nie
bez znaczenia jest fakt, øe za pomoc¹
jednego narzÍdzia moøna uruchamiaÊ
urz¹dzenia bazuj¹ce na dwÛch od-
miennych rodzinach mikrokontrolerÛw.

W†dalszym opisie skoncentrujemy siÍ
na mikrokontrolerach AVR.

Rozpoznanie bojem
Najlepsz¹ metod¹ zapoznania siÍ

z†programem bÍdzie zrealizowanie kon-
kretnego projektu. Pos³uøymy siÍ do
tego przyk³adem, zawartym w†pakiecie,
z†tym øe dla lepszego zilustrowania
wspÛ³pracy VMLAB-a z†kompilatorem
C asemblerowa wersja oryginalna zo-

sta³a przet³umaczona na ten
w³aúnie jÍzyk. Program przedsta-
wiono na list. 1. Zanim przyst¹-
pimy do pracy, musimy zainsta-
lowaÊ úrodowisko Visual Micro
Lab. Moøna to zrobiÊ, pobieraj¹c
odpowiednie pliki ze strony
http://www.amtools.net, wersja
ewaluacyjna 3.6 jest takøe do-
stÍpna na naszym CD-ROM-ie

(CD-EP5/2003B). Zainstalowanie wersji
pe³nej wymaga wype³nienia odpowied-
niego formularza i†dokonania op³aty.
Po wykonaniu tych czynnoúci, drog¹
elektroniczn¹ dostarczane s¹ kody dla
wersji pe³nej. Przed dokonaniem zaku-
pu warto wyprÛbowaÊ VMLAB-a, insta-
luj¹c 21-dniow¹ wersjÍ ewaluacyjn¹.
Jedynym jej ograniczeniem jest
okreúlony czas dzia³ania, po przekro-
czeniu ktÛrego nie bÍdzie moøliwe
skompilowanie programu do postaci
wykonywalnej. Program moøna rÛw-

Program Visual Micro Lab przedstawialiúmy
na ³amach EP juø kilka razy. Stworzy³a go

grupa inøynierÛw z†kilku krajÛw, zrzeszonych
w†wirtualn¹ grupÍ Advanced Micro Tools

z†siedzib¹ w†Hiszpanii. Mimo øe od ukazania
siÍ ostatniego artyku³u nie minÍ³o duøo czasu,
twÛrcom programu uda³o siÍ wypuúciÊ do dziú
juø dwie kolejne wersje programu. Aktualna

nosi numer 3.6. Przyjrzymy siÍ jej dok³adniej,
gdyø z†pewnoúci¹ Visual Micro Lab

zainteresuje wielu konstruktorÛw
wykorzystuj¹cych w†swojej pracy

mikrokontrolery ST62 i†AVR.

Przypomnijmy pokrÛtce najwaøniej-
sze w³asnoúci programu. Visual Micro
Lab to zintegrowane úrodowisko pro-
jektowe (Integrated Development Envi-
ronment - IDE), s³uø¹ce do uruchamia-
nia systemÛw wykorzystuj¹cych mikro-
kontrolery ST62 lub AVR. Aktualnie
obs³ugiwane s¹ modele:
- w†rodzinie ST6: ST6200, 01, 03, 08,
09, 10, 15, 20, 25,

- w†rodzinie AVR: ATiny11, ATiny12,
ATiny15, ATiny22, AT90S2343,
AT90S2323, AT90S1200,
AT90S2313, AT90S4433,
AT90S4414, AT90S8515,
AT90S4434, AT90S8535,
ATmega8, ATmega16, ATme-
ga161, ATmega162, ATme-
ga32, ATmega64, ATmega128.
Najwaøniejsz¹ - i†trzeba przy-

znaÊ - niezbyt czÍsto spotykan¹
w†innych programach cech¹ VMLAB-a
jest po³¹czenie funkcji klasycznego úro-
dowiska IDE oraz symulatora najczÍú-
ciej wykorzystywanych w†systemach
mikroprocesorowych uk³adÛw peryferyj-
nych, w†tym analogowych. Do dyspozy-
cji mamy m.in.: rezystor, kondensator,
diodÍ LED, klawiaturÍ 4x4, wzmacniacz
operacyjny, komparator, przetworniki C/
A i†A/C, funktory logiczne, generatory

Rys. 1. Uproszczony schemat
układu eksperymentalnego

Atuty VMLAB−a
Najważniejszą cechą VMLAB−a jest

połączenie funkcji klasycznego środowis−
ka IDE oraz symulatora najczęściej

wykorzystywanych w systemach
mikroprocesorowych układów peryferyj−

nych, w tym analogowych.

Rys. 2. Zasada wytwarzania
przebiegu sinusoidalnego z przebiegu
PWM

Program wspomagający realizację projektów
na mikrokontrolerach AVR i ST62
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nieø zobaczyÊ ìw akcjiî na filmie avi
zamieszczonym na CD-EP5/2003B.
Instalator zak³ada na dysku domyúl-

ny katalog c:\VMLAB , w†ktÛrym
umieszcza wszystkie niezbÍdne pliki.
Visual Micro Lab zawiera w†sobie
asembler obs³ugiwanych mikrokontrole-
rÛw, umoøliwia rÛwnieø korzystanie
z†kompilatora GNU C†(GCC) (tylko dla
AVR-Ûw) lub dowolnego innego kom-
pilatora generuj¹cego pliki COFF.
Kompilatory musz¹ byÊ jednak zainsta-
lowane na komputerze niezaleønie od
VMLAB-a. Po wykonaniu wszystkich
czynnoúci niezbÍdnych do przygotowa-
nia sobie úrodowiska moøemy juø
przyst¹piÊ do prawdziwej pracy inøy-

nierskiej. Wracamy zatem do projektu,
ktÛry bÍdziemy wspÛlnie tworzyÊ. BÍ-
dzie to generator przebiegu sinusoidal-
nego, wykorzystuj¹cy Timer†1 pracu-
j¹cy w†trybie modulatora PWM.
Na rys. 1†przedstawiono uproszczo-

ny schemat ideowy uk³adu ekspery-
mentalnego. Zasada dzia³ania jest na-
stÍpuj¹ca. Timer†1†generuje przebieg
PWM o†zmienianym w†doúÊ specyficz-
ny sposÛb wspÛ³czyniku wype³nienia
(rys. 2). Do wyjúcia OC1 (PB3) do³¹-
czono uk³ad ca³kuj¹cy sk³adaj¹cy siÍ
z†rezystora R2 i†kondensatora C1.
W†wyniku dzia³ania tego uk³adu na
wyjúciu FIL_OUT, przy odpowiednim
doborze wartoúci elementÛw R2 i†C1,
uzyskuje siÍ przebieg sinusoidalny.
Wartoúci kolejnych prÛbek sinusoidy
s¹ zawarte w†tablicy sine_tbl. Zmienia-
j¹c jej poszczegÛlne elementy w†niemal
natychmiastowy sposÛb, bez koniecz-
noúci programowania rzeczywistego
mikrokontrolera, moøna zaobserwowaÊ
skutek na wyjúciu uk³adu. Podobnie
zreszt¹ bÍdziemy badaÊ przebiegi wyj-
úciowe dla rÛønych wartoúci elemen-
tÛw RC. WartoúÊ prÛbki jest pobierana
w†przerwaniu Timera 1, generowanego
po jego przepe³nieniu.
Maj¹c podstawy teoretyczne, moøe-

my przyst¹piÊ do dzie³a. Otwieramy
nowy projekt, wybieraj¹c polecenie
Project->New project. Pojawia siÍ okno
kreatora projektu (rys. 3), w†ktÛrym

naleøy wype³niÊ odpowiednie pola. Po
pierwsze: nadajemy nazwÍ np. sin-
wavec.prj, po drugie: wybieramy typ
mikrokontrolera, np. AT90S2313, po
trzecie okreúlamy, czy bÍdzie to pro-
gram pisany w†asemblerze, czy w†jÍzy-
ku C. Przyjmujemy wersjÍ GNU C
i†zgadzamy siÍ na automatyczne wyge-
nerowanie pliku makefile, co z†pew-
noúci¹ ucieszy wielu z†nas. Na koniec
wreszcie decydujemy o†tym, jakie pli-
ki ürÛd³owe bÍd¹ wchodzi³y do projek-
tu (przycisk Add this to list). W†na-
szym przyk³adzie bÍdzie to tylko jeden
plik. Akceptujemy proponowan¹ nazwÍ
sinewave.c, na co program odpowiada,
øe plikiem wynikowym bÍdzie sinewa-
ve.hex. Ustawienia akceptujemy naciú-
niÍciem OK.
Teraz ukazuj¹ siÍ liczne okna pro-

gramu, z†czego dwa s¹ najwaøniejsze
na tym etapie. Pierwsze z†nich zawie-
ra treúÊ pliku makefile. Moøna go rÍcz-
nie wyedytowÊ, jeúli proponowane
ustawienia s¹ nieodpowiednie.
W†szczegÛlnoúci, czÍsto bÍd¹ zapewne
zmieniane opcje optymalizacji kompi-
latora (pozycja #compiler flags). Jak
widaÊ na rys. 4, okno ma jeszcze za-
k³adkÍ sinwavec.c, w†ktÛrej bÍdziemy
tworzyÊ wersjÍ ürÛd³ow¹, ale to za
chwilÍ. Wczeúniej zajmiemy siÍ na-
szym wirtualnym sprzÍtem. W†tym ce-
lu odszukujemy tzw. okno projektu,
np. wybieraj¹c polecenia View->Project
File. S¹ juø tam pewne dane przenie-
sione z†pliku makefile oraz dodatkowe

List. 1
#define __AVR_AT90S2313__
#include <io.h>              // Most basic include files
#include <interrupt.h>      // Add the necessary ones
#include <signal.h>          // here
#include <progmem.h>

unsigned char angle;

unsigned char sine_tbl[128] __attribute__((progmem)) =
    {
     0,0,1,1,2,3,4,6,7,9,10,12,14,16,18,21,23,25,28,31,
     33,36,39,42,45,48,51,54,57,60,64,67,70,73,76,79,82,
     85,88,91,94,96,99,102,104,106,109,111,113,115,117,118,
     120,121,123,124,125,126,126,127,127,127,127,127,127,
     127,126,126,125,124,123,121,120,118,117,115,113,111,
     109,106,104,102,99,96,94,91,88,85,82,79,76,73,70,67,
     64,60,57,54,51,48,45,42,39,36,33,31,28,25,23,21,18,16,
     14,12,10,9,7,6,4,3,2,1,1,0,0,0,0,0
    };

SIGNAL(SIG_OVERFLOW1)
{
 unsigned char temp;

 angle=(angle)&0x7f;
 temp=PRG_RDB(&sine_tbl[angle++]);
 OCR1H=0;
 OCR1L=temp;
}

int main(void)
{
 DDRB=0x08;
 sbi(TIMSK,TOIE1);
 TCCR1A=1<<PWM10 | 1<<COM1A1;
 TCCR1B=1<<CS10;
 angle=0;
 sei();
 while(1);
}

Rys. 3. Okno kreacji projektu

Rys. 4. Plik makefile generowany
przez VMLAB

Rys. 5. Okno projektu



   67Elektronika Praktyczna 5/2003

P  R  O  G  R  A  M  Y

informacje o†montowanym uk³adzie.
ProponujÍ zmieniÊ czÍstotliwoúÊ rezo-
natora kwarcowego na 8†MHz - do we-
ryfikacji uk³adu dysponowa³em akurat
tak¹ wersj¹. W†polu CLOCK naleøy
wiÍc wpisaÊ parametr 8meg.
Teraz pozosta³o jeszcze do³¹czenie

uk³adu ca³kuj¹cego. Nie sposÛb tu
omÛwiÊ wszystkich moøliwoúci, jakie
daje nam w†tym wzglÍdzie program.
S¹ one úwietnie opisane wraz z†przy-
k³adami w†pomocy, niestety tylko
w†wersji angielskiej. Nasz uk³ad
ca³kuj¹cy bÍdzie mia³ postaÊ:
R2 PB3 fil_out 100K
;R2 dołączony do PB3
;i do wyjścia fil_out
C1 fil_out vss 10n
;C1 dołączony do wyjścia
;fil_out i masy
Ponadto warto do³¹czyÊ oscy-

loskop do koÒcÛwki PB3 (prze-
bieg PWM) i†do wyjúcia fil_out:
.plot v(PB3)
v(fil_out);podłączenie
oscyloskopu
ZawartoúÊ ca³ego pliku projek-

tu przedstawiono na rys. 5. Po
wykonaniu wszystkich czynnoú-
ci edycyjnych okno to moøna
zamkn¹Ê. Teraz moøemy przyst¹-
piÊ do pisania wersji ürÛd³owej nasze-
go programu. Zalet¹ VMLAB-a jest
moøliwoúÊ zdefiniowania piÍciu rÛø-
nych organizacji ekranu. Jest to bardzo
przydatna w³aúciwoúÊ, poniewaø roz-
mieszczenie wszystkich okien progra-
mu nawet na monitorze 17-calowym,
przy rozdzielczoúci 1024x768 jest pra-
wie niemoøliwe. ZapamiÍtywanie wi-
dokÛw pozwoli szybko przechodziÊ
pomiÍdzy ekranami zawieraj¹cymi is-
totne w†danym momencie informacje.
Widoki zmienia siÍ, wybieraj¹c odpo-

wiedni¹ pozycjÍ z†roz-
wijanej listy umieszczo-
nej na koÒcu paska na-
rzÍdziowego (rys. 6).
Pierwsza faza programu

najczÍúciej bÍdzie polega³a na siÍganiu
do ürÛd³a, kompilowaniu programu,
przegl¹daniu komunikatÛw kompilato-
ra i†ponownej edycji. Warto wiÍc
w†jednym z†widokÛw podzieliÊ ekran
tylko na dwa okna: edycyjne i†komu-
nikatÛw. Zapewni nam to duø¹ czytel-
noúÊ i†komfort podczas wstÍpnych
prac z†programem. Po doprowadzeniu
tekstu programu do stanu umoøliwia-
j¹cego kompilacjÍ, uruchamiamy j¹,
wybieraj¹c polecenie Project->Build.

Moøna teø uøyÊ klawisza F9 lub ikony
Build (úrodkowa ikona na pasku narzÍ-
dziowym). W†trakcie kompilacji w†ok-
nie Messages pojawiaj¹ siÍ wszystkie
komunikaty generowane przez kompi-
lator. Jeúli wyst¹pi choÊby jeden b³¹d,
kursor edycyjny zostanie ustawiony
w†podejrzanym o†to miejscu. Czasami
jednak faktyczna nieprawid³owoúÊ mo-
øe mieÊ miejsce gdzie indziej. Na
przyk³ad brak úrednika koÒcz¹cego li-
niÍ programu C spowoduje wyst¹pie-
nie b³Ídu dopiero w†dalszej czÍúci.

Wszystkie miejsca, na ktÛre trzeba
zwrÛciÊ uwagÍ, s¹ sygnalizowane wy-
krzyknikami umieszczonymi przed
treúci¹ komunikatu. Kolor øÛ³ty ozna-
cza, øe jest to tylko ostrzeøenie, pro-
gram bÍdzie dzia³a³. Przyk³adowo
VMLAB ostrzega w†ten sposÛb przed
zadeklarowaniem zmiennej, ktÛra nie
jest uøywana dalej w†øadnym miejscu
programu. Gorzej, gdy wykrzyknik ma
kolor czerwony. W†takiej sytuacji kom-
pilator nie tworzy pliku wykonywalne-
go, a†wiÍc uruchomienie programu nie
bÍdzie moøliwe. Tego typu b³Ídy trze-
ba bezwzglÍdnie poprawiÊ. Czasami
zdarza siÍ, øe jedna nieprawid³owoúÊ
w†ürÛdle powoduje wygenerowanie ca-

³ej listy b³ÍdÛw. Ich eliminacja
jest tym, co programiúci lubi¹
najbardziej. Niestety wszystko co
dobre szybko siÍ koÒczy i†wresz-
cie pojawia siÍ oczekiwany mi-
mo wszystko komunikat Suc-
cess! All ready to run (rys. 7).
Od tego momentu rozpoczyna

siÍ kolejna faza uruchamiania
aplikacji - symulacja. Teraz mo-
øemy stworzyÊ sobie kolejny ek-
ran roboczy, ktÛry bÍdzie zawie-
ra³ przydatne do symulacji
sk³adniki - przyk³ad pokazano
na rys. 8 . Na pewno warto
umieúciÊ na nim choÊby nie-
wielkie okno ürÛd³a programu.
Wykorzystuj¹c krokowy tryb
pracy, bÍdzie w†nim zaznaczana

aktualnie wykonywana instrukcja na
poziomie odpowiadaj¹cym wersji ürÛd-
³owej (jÍzyk C lub asembler). Jeúli pro-
gram jest napisany w†C, a†chcemy wy-
konywaÊ go na poziomie rozkazÛw
mikrokontrolera, konieczne bÍdzie do-
³oøenie okna Program memory i†uczy-
nienie go aktywnym. Po lewej stronie
kaødej instrukcji widniej¹ malutkie
przyciski ekranowe. Ich naciúniÍcie
powoduje wstawienie w†danym miejs-
cu programu pu³apki (breakpoint). Ak-
tywnych pu³apek moøe byÊ wiele.

Interesujący wybór
Twórcy VMLAB−a skupili się na dwóch

rodzinach mikrokontrolerów:
− ST62: ST6200, 01, 03, 08, 09, 10,

15, 20, 25,
− AVR: ATiny11, ATiny12, ATiny15,
ATiny22, AT90S2343, AT90S2323,

AT90S1200, AT90S2313, AT90S4433,
AT90S4414, AT90S8515, AT90S4434,

AT90S8535, ATmega8, ATmega16,
ATmega161, ATmega162, ATmega32,

ATmega64, Atmega128.
Wybór jest − jak na Polskę − nietypowy,

ale dowodzi dużej popularności ST62
w innych krajach europejskich.

Rys. 6. Pasek narzędziowy programu Visual Micro Lab

Rys. 7. Przykładowy widok okna roboczego Rys. 8. Program “Visual Micro Lab” podczas pracy
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Podczas prac uruchomieniowych czÍs-
to zachodzi koniecznoúÊ pomiaru cza-
su wykonywania siÍ np. okreúlonej
procedury. Zadanie to nie jest najmoc-
niejsz¹ stron¹ VMLAB-a, lepiej chyba
robi to AVR Studio, jednak VMLAB
ma w†tym wzglÍdzie pewn¹ doúÊ at-
rakcyjn¹ cechÍ. Wyúwietla on miano-
wicie w†oknie programu graficzn¹ in-
terpretacjÍ ìczasu przebywaniaî jed-
nostki centralnej w†okreúlonym miejs-
cu programu. S¹ to øÛ³te paski na³o-
øone na poszczegÛlne instrukcje. Trze-
ba jednak pamiÍtaÊ, øe skala czasu jest
logarytmiczna! Trudno mÛwiÊ
o†precyzji takiego pomiaru, ale
w†niektÛrych sytuacjach infor-
macja podana w†ten sposÛb mo-
øe okazaÊ siÍ bardzo przydatna.
Nie sposÛb wyobraziÊ sobie

uruchamiania programu bez moø-
liwoúci podgl¹dania zasobÛw
mikrokontrolera. W†Visual Micro
Lab oczywiúcie tak¹ moøliwoúÊ mamy
i†to w†doúÊ atrakcyjnej formie (rys. 8).
PoszczegÛlne komponenty mikrokontro-
lera s¹ zgrupowane w†kilku niezaleø-
nych oknach, np.: rejestry, pamiÍÊ pro-
gramu, pamiÍÊ danych SRAM, pamiÍÊ
EEPROM, porty oraz UART, timery,
watchdog. ZawartoúÊ kaødego z†nich
moøe byÊ wyúwietlana w†postaci binar-
nej, hexadecymalnej, ca³kowitoliczbo-
wej, a†nawet w†kodach ASCII. Na
wszystkie pola jest na³oøony pÛ³prze-
zroczysty pasek graficzny, ktÛry w†po-
staci analogowej pokazuje stan danego
komponentu. Kaødy z†rejestrÛw moøe
byÊ w†dowolnej chwili zmieniony. Nie-
stety nie dotyczy to licznika programu,
co oznacza, øe program moøe byÊ wy-
konany tylko w†takiej kolejnoúci, jak
w†uk³adzie rzeczywistym. Uøytkownik
ma teø moøliwoúÊ podgl¹dania zmien-
nych programu. Bywaj¹ z†tym niestety
problemy, zmienne te nie zawsze s¹
dostÍpne. Nie moøna teø modyfikowaÊ
w†prosty sposÛb ich wartoúci. Szkoda.
Pewnym wyjúciem z†sytuacji jest jedy-
nie podejrzenie miejsca przechowywa-
nia (rejestry, pamiÍÊ RAM) i†edycja na
tym poziomie. Specyficznym oknem
VMLAB-a jest panel tzw. steruj¹cy. Za-
wiera on zewnÍtrzne urz¹dzenia pery-
feryjne wykorzystywane w†aplikacji

Także dla fanów AVR−GCC
Naturalnym “partnerem” VMLAB−a jest

kompilator AVR−GCC. Dzięki temu
połączeniu fani tego kompilatora

uzyskują łatwy dostęp do symulacji
pisanych programów.

(rys. 9). Moøe to byÊ klawiatura 4x4,
alfanumeryczny wyúwietlacz LCD, wir-
tualny terminal TTY, diody úwiec¹ce,
potencjometry. Ich parametry konfiguru-
je siÍ w†oknie projektu.
Popatrzmy teraz, jak to wszystko

dzia³a w†praktyce. Program jest juø
wyczyszczony ze wszystkich b³ÍdÛw,
moøemy go uruchomiÊ. Przygotowuje-
my sobie ekran np. tak, jak rys. 8†i†na-
ciskamy ikonkÍ z†semaforem lub kla-
wisz F5. Nasz wirtualny system zaczy-
na dzia³aÊ. Na oscyloskopie pojawiaj¹
siÍ przebiegi generowane przez mikro-
kontroler. Aby przyjrzeÊ siÍ nieco do-
k³adniej, jak to robi, zatrzymujemy
program, naciskaj¹c ikonkÍ ze znakiem
Stop i†kolejne rozkazy wykonujemy
krokowo. Tu okazuje siÍ, øe w³aúciwa
czÍúÊ programu to martwa pÍtla,
w†ktÛrej mikrokontroler w³aúciwie
przebywa przez wiÍkszoúÊ czasu. Jest
to bardzo wyraünie widoczne na wspo-
mnianych wczeúniej paskach pod in-
strukcjami programu. CPU jedynie na
krÛtkie okresy przechodzi do procedu-
ry obs³ugi przerwania, w†ktÛrej nastÍ-
puje modyfikacja parametrÛw genero-

wanego przebiegu PWM. Krokowe wy-
konywanie programu do momentu, aø
zostanie wygenerowane przerwanie
mog³oby trwaÊ bardzo d³ugo. Dlatego
wygodniej bÍdzie za³oøyÊ pu³apkÍ
w†procedurze przerwania i†puúciÊ pro-
gram w†trybie ci¹g³ym. Po zatrzymaniu
siÍ na pu³apce, kontynuujemy pracÍ
krokowo. Wykonuj¹c program, warto
przyjrzeÊ siÍ, jak s¹ mieniane zawar-
toúci rejestrÛw np. OCR1nAAH i†OCR-
nAL (okno Peripherals->Timer†1).
Przebieg na oscyloskopie moøe byÊ
doúÊ swobodnie skalowany, umoøliwia-
j¹c ogarniÍcie ca³oúci w†wiÍkszym cza-
sie, a†takøe przyjrzenie siÍ detalom
z†rozdzielczoúci¹ 100 ns/dzia³kÍ. Usta-

wiaj¹c na oscylogramie dwa kursory,
moøna dokonaÊ prostego pomiaru cza-
su. Ciekawym doúwiadczeniem moøe
byÊ np. zbadanie wp³ywu wartoúci ele-
mentÛw R2, C1 na kszta³t generowane-
go przebiegu. Odpowiednie modyfika-
cje przeprowadzamy w†oknie projektu.

To jest Twoja chwila
prawdy
Moøna powiedzieÊ, øe wszystko, co

robiliúmy do tej pory, to by³a tylko za-
bawa. To doúÊ przyjemne wraøenie, gdy
opracowuj¹c powaøne projekty, wyko-
rzystuj¹c profesjonalne narzÍdzie, czer-
piemy tak¹ radoúÊ z†pracy. Teraz jed-
nak przechodzimy do koÒcowego etapu
projektu. Odk³adamy program, bierzemy
lutownicÍ do rÍki i... z†drøeniem serca
oczekujemy koÒcowego rezultatu. Nasz
projekt nie by³ zbyt skomplikowany,
trzeba to uczciwie przyznaÊ. Ale zda-
rza³o siÍ wielokrotnie z†innymi narzÍ-
dziami, øe nawet w†takich przypadkach
wyniki symulacji bywa³y raø¹co od-
mienne od rzeczywistych. Maj¹c akurat
pod rÍk¹ zestaw, na ktÛrym mÛg³bym
zweryfikowaÊ dzia³anie opisywanego

wyøej projektu, nie mog³em sobie
tego odmÛwiÊ. Oscylogramy uk³a-
du rzeczywistego zdjÍte oscylo-
skopem cyfrowym s¹ przedsta-
wione na rys. 10 i†11. Rezultat
porÛwnania jest niemal szokuj¹-
cy. Okaza³o siÍ, øe symulacja da-
³a bardzo wierne wyniki zarÛwno
pod wzglÍdem jakoúciowym, jak

i†iloúciowym. Oczywiúcie taki test nie
moøe byÊ podstaw¹ do wydania ca³ko-
wicie wiarygodnej opinii o†programie.
Mimo to oceniam program bardzo wys-
oko, a†wykorzystujÍ go juø od doúÊ
dawna. Nie jest on pozbawiony pew-
nych b³ÍdÛw, ale jak widaÊ rozwija siÍ
w†sposÛb ci¹g³y, daj¹c nadziejÍ na
stopniowe eliminowanie b³ÍdÛw. Bar-
dzo duø¹ zalet¹ jest natomiast doúÊ
dobra integracja z†kompilatorem GCC
oraz duøo lepsze symulowanie wewnÍt-
rznych blokÛw funkcjonalnych mikro-
kontrolera, niø robi to AVR Studio. Za-
chÍcam do wyprÛbowania.
Jaros³aw Doliñski, AVT
jaroslaw.dolinski@ep.com.pl

Rys. 9. Okno panelu sterującego

Rys. 11. Przebieg rzeczywisty w po−
większeniu

Rys. 10. Przebieg generowany
w układzie rzeczywistym


